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Notice 
Microsoft Windows and Adobe Photoshop, Apple Mac OS X and ColorSync are registered trademarks of their respective companies.  
 
The name Phase One is trademark of Phase One A/S, Denmark. 
 
All specifications are subject to change without notice.  
Phase One takes no responsibility for any loss or damage sustained while using their products. 
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1. Introduction 
 
Color Management is often thought of as difficult to understand and difficult to use. In fact, with a little time and practice, 
it is possible both to understand and use color management effectively.  
 
This Color Management User Guide is written with digital photographers in mind. The aim is to provide sufficient 
information, for the digital photographer, so that the finished result, whether it is a JPEG file for the internet, an image 
made on an ink jet printer, or a photograph reproduced in a magazine, is as faithful to the original subject as is possible. 
 
Standardization of color values and calibrating devices 
 
The key to successful color management is standardization.  
 
The basic concept is this:  
If the color values of the original subject are known, and measured accurately, then it must be possible to observe and 
measure any changes in color value as the subject is reproduced, and at any stage in the reproduction process. 
In fact changes in color value always occur. Some changes are a result of the color space gamut (“gamut” is another 
word for “range”) – for example a printer may not be able to produce the same range of colors that can be seen on a 
monitor.  
Other changes in color value occur when the same color is viewed in different environments. 
 
The key to a successful calibration is to put every device into a known state, which is to say the device default settings.  
The color output of each device can then be measured and compared. 
 
When measuring the color output of any device the original subject  
is often a color chart with known values. Each stage in the process, from taking the picture (Camera), viewing and 
editing the picture (Monitor), and finally publishing the picture (Printer or Monitor),  
can then be evaluated and compared to the original subject. 
 
Workflow Devices 
There are typically three devices in any workflow: The camera, the monitor and the printer. These devices must be 
calibrated before use. Although a detailed description is provided later in this guide, the key steps are as follows: 
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The camera – Every Phase One camera back is calibrated before leaving the factory. Calibration information is 
automatically transferred to the computer when the camera back is connected to a computer.  
All the photographer needs to do is to specify the light source, the scene characteristics and the gray balance in the 
Phase One software. 
 
The monitor – It is important to get a good match between the monitor color temperature and the environment color 
temperature, as well as ensuring that the monitor shows accurate color and the best possible range of brightness and 
contrast. 
  
The printer – Often a printer comes complete with a profile (a description of how it reproduces color).  
The profile is used in the workflow to ensure the best possible reproduction quality. The photographer may have a 
printer profile, supplied by a customer, or printing house. 
 
In addition there is a theoretical fourth device – The Profile Connecting Space (PCS). This can be considered the 
“perfect” device where every humanly visible color can be reproduced.  
As the name - Profile Connecting Space  - suggests this device actually forms a link between all other profiles. It is 
within the PCS that the computer calculates the correct balance and correction when moving from one physical device to 
another. 
 
The purpose of profiles 
 
Human Vision and color values 
The visible spectrum is a very narrow section of a vast range of radio waves. At one end of the entire range are; long 
wave radio waves, VHF radio, television, Radar, microwaves and infrared. Then comes the visible spectrum, followed by 
ultra violet light, X-rays, Gamma rays and cosmic rays. 
 
To a certain extent human vision can be described and measured. Thus we can say that most people with healthy vision 
can see the same visible spectrum. 
 
The visible spectrum can be described both by name and by number. Numerically the visible spectrum starts at 380 nm 
(nanometers) and ends at 780 nm. So when we humans register a wavelength of about 450 nm we say we see “blue”. 
When we register a wavelength of about 700 nm we say that we see “red”. 
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We also say that the sky is “blue”, that the setting sun is “red” and that grass is “green”, and we can all agree at a 
superficial level. However, when it comes to evaluating and comparing images we can be remarkably accurate as well 
as easily fooled. 
Therefore we need an objective method to measure and define color values, upon which we can all agree. Color 
management is the method and profiles are the key. 
 
Using profiles in color management  
A profile is an accurate description of how a device reproduces color. A device can be a camera, a screen, or a printing 
process. The profile is analyzed by a computer, which then automatically compensates for any variations in the way a 
series of devices reproduce color. In this way the color of the original subject can be accurately reproduced, and 
measurably consistent, from shooting to the finished result.  
 
A typical setup in a photographer’s studio may comprise of a Phase One camera, a high-end computer and monitor as 
well as photographic quality printer. Every shot that is taken goes from the Phase One camera, through the computer, 
and is shown on the monitor. The computer reads the profiles of each device, compensates for the way each device 
reproduces color, and displays the finished result on the screen.  
It is then the job of the photographer to decide if any further adjustment is needed. Computers equipped with device 
profiles show only how a device reproduces color. They do not tell the  
photographer what to do if the device, or process, cannot reproduce the color accurately. Often it will be the printing 
process that sets the greatest limitation to color reproduction, although each step in the process adds its own layer of 
limitations. 
 
Color spaces – color in 3D 
People describe colors in a variety of ways, and most descriptions are entirely subjective. To avoid human error, several 
systems have been developed to give color a value and to define relationships between colors. It is beyond the scope of 
this guide to describe them all in detail - fortunately they have many things in common. Each system can describe 
individual colors, as well as a range of colors. 
 
Individual color  
The relationship between individual colors, and ranges of colors,  
are often defined in three dimensions. These dimensions have names:  
 
Hue - The name of the color. 
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Saturation - The strength of the color. Neutral gray has no  
saturation. As more color is added to the neutral gray the level  
of saturation increases. 
 
Brightness - The measurement of light transmitted or reflected from an image The hue of an image may be blue, but 
the brightness can vary considerably. 
 
A combination of Hue, Saturation and Brightness (HSB) defines an individual color. 
 
To visualize this three-dimensional space, imagine a globe with a North Pole, an equator, and a South Pole. Let us call it  
the HSB globe. 
 
At the North Pole everything is pure white, no other colors are 
visible, there is maximum brightness. Moving southwards, 
towards the equator, colors start becoming visible.  
 
If the globe is sliced in half, at the equator, each color can be 
seen as part of a circular spectrum. At the core of the globe 
neutral gray is the meeting point of all colors. 
 
As the colors move away from the core, they become stronger, 
their saturation increases. At the surface of the globe saturation is 
100%, and each color is easily identified. Following the equator 
around the globe red blends through magenta and violet to blue. 
Blue merges into green and green merges into yellow. Finally 
yellow merges back into red. 
 
Moving onwards again towards the South Pole, colors gradually 
become darker. Finally, at the South Pole, everything is black. 
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Color gamuts – Color in 2D 
A way of describing the range of color that a device is able to  
register is to say that it has a “gamut”. Gamut is another word for range and it is 
frequently used when describing the color limitations of devices. 
 
The gamut of visible colors, represented within the HSB globe, can also be shown as a 
flat, two-dimensional chart. The shape of the chart shows the range of colors that the 
human eye can register.  
 
 

The black border indicates the 
approximate limit of each device below. 
 
A Phase One camera has a very large 
dynamic range – which also gives a 
very large gamut. 
 
Film has a slightly smaller gamut than a 
Phase One camera, and the gamut of a 
high quality film scanner is slightly 
smaller than film.  

 
The color gamut of a high quality computer screen is slightly different 
to the gamut of a film scanner.  
 
Finally a printer, or printing process, often has a very different, and 
much smaller, gamut. 
 
Not only must we take into account the limited range of colors that 
can be reproduced as the image moves from the camera to the final 
print, we must also be aware that the gamuts do not always fit inside 
each other. Sometimes gamuts can overlap, shift or expand in any 
direction. Profiles are used to compensate for these reductions and 
shifts. 

Visible 
Spectrum 

Phase 
One 

Film Scanning 

Monitor Printer
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2. Color Management for Mac 
 
Setting up the hardware 
 
The camera 
Every Phase One camera back is calibrated before it leaves the  
factory. When the camera is connected to the computer, calibration data is transferred automatically. The photographer 
need only specify the light source, the scene characteristics and the gray balance, using the Phase One software. 
 
The monitor 
Next to the camera this is the most vital piece of equipment for the photographer. Digital photography is difficult without 
an accurate picture of what the camera registers, and what the printer can reproduce. 
 
A Mac can have two types of monitor, a CRT type monitor (Preferably with a Sony Trinitron tube) or a Flat Panel (Active 
Matrix TFT).  
! Be aware, that when calibrating an Active Matrix TFT monitor you have to make sure the resolution is set to the 
“native” or maximum resolution, otherwise the result of especially gamma correction will be wrong. 
No matter what type is preferred, only high quality monitors should be used. 
 
All newer monitors can be used with ColorSync to ensure correct calibration. ColorSync is a color management 
technology developed by Apple.  
 
Although there are many methods used to calibrate monitors (Electronic devices to place on the monitor, monitors with 
auto calibration features etc.). Phase One recommends the following simple methods for good results. 
No special equipment is needed. 
 
Calibration of Monitors in Mac OS X: 
 
Turn the monitor on and let it reach normal working temperature – this may take 30 min. 
 

• Open the System Preferences available in the Dock or inside the Applications directory. 
 

• Select the Desktop control panel and from the Image selection popup select Solid Colors, Then select the one 
named Solid Gray. The screen background is now set to a neutral gray. 
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• Open “Displays” inside the System Preferences and select the “Color” tab 

 
• Follow the on screen guidelines to calibrate the display and be sure to select Target Gamma 1.8 and Target white 

point D 65 (6500 Kelvin). 
 

 
Some monitors (e.g. Apples Professional Studio Monitors ) lets you adjust the Brightness and Native Gamma values 
from within the Display Preferences, if the above procedure did not let you adjust these values, this is not supported on 
your monitor, and you will have to adjust this manually as explained below. 
 
 
Adjusting the Brightness and Contrast manually: 
 
Turn the monitor on and let it reach normal working temperature – this may take 30 min. 
 

• Set the contrast to 100%. Most monitors have control buttons at the front. Most TFT monitors do not let you set 
the contrast, so here you will only set the brightness. 

• Drag this document to align the black rectangle below with the bottom of the screen edge boundary. 
 

• Adjust the brightness of the screen so that the black rectangle below is is almost as black as the dark border of 
the screen. With some monitors it is possible to move the screen image to expose a larger border. This may help 
when evaluating how dark the border should be. 

 
• When this adjusting is done you might want to adjust the contrast back to less than 100% depending on the 

quality of your monitor. 
 

 
 
 
 
 
Setting up Software 
 

Drag the document to place this black rectangle at the edge of the screen and adjust the brightness so that black 
is almost as black as the boundary black edge of the screen. Also you should be able to see all tree fields below. 

3 fields
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Setting up the Software 
 
Setting up ColorSync System settings 
 

• Select ColorSync from the System Preferences  
• Set the RGB Default profile to “Adobe RGB 

(1998)” 
• Set the CMYK Default to the desired CMYK 

profile* 
• Set the Gray Default to “Generic Gray” 

 
*For “on the fly” CMYK conversion Phase One Installs 
the following CMYK profiles (by process type/region): 
Offset Print - DIC Catalog, Offset Print - Euro Catalog, 
Offset Print - Toka Catalog, Offset Print - Toyo Catalog, Offset Print - US Catalog. 

 
When ColorSync System Preferences are setup Capture One and Photoshop can subscribe to these settings. 
 
Setting up Photoshop Color Settings 
 

• Start Photoshop 
• In the File menu, select Color Settings... 
• Select “Phase One Workflow” in settings pop up menu in the top. 
 

If Colorsync System Preferences are setup correctly Photoshop will now now show 
accurate RGB or CMYK values. 
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Visual Inspection 
To test the Color management setup and make a visual inspection open the 
“PhaseOne-CMS Checker Lowres.tif” in Photoshop (Located in the “Extras” folder 
on the CD). 
The file should have an “Adobe RGB 1998” embedded profile, and therefore no 
color conversion is needed. 
 
Areas of special interest when evaluating the image: 
 
The gray scale at the bottom should be evenly distributed, and you should be able to 
se the transition between 100 to 95 and 5 to 0. 
The field in the lower right color of the colorchart should be deep red burgundy. 
Details in the black hat of the lady in the lower right corner should be visible. 
Look at the fruit and vegetables  in the top and judge if it looks like natural colors. 
Skin tones of the portraits should look naturally 
Finally the details in the waterline along the ship should be visible 
 
Setting up Capture One Color Settings 
 
In the Capture One Software: 
 

• Select Preferences from the Capture One menu 
• Select ColorSync and setup which camera back and 

light source you use. 
•  

If your ColorSync System preferences is already setup 
there is no need to set up more. 
 
For instructions on how to use color management inside 
the software, please consult the Capture One User Guide. 
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3. Color management for Windows 
 
Setting up the hardware 
 
The camera 
Every Phase One camera back is calibrated before it leaves the factory. When the Phase One back is connected to the 
computer, calibration data is transferred automatically. The photographer need only specify light source, scene 
characteristics and gray balance, using the Phase One software. 
 
The monitor 
Next to the camera this is the most vital piece of equipment for the photographer. Digital photography is difficult without 
an accurate picture of what the camera registers, and what the printer reproduces. Only high quality monitors should be 
used. 
 
A Windows PC can have two types of monitor, a CRT type monitor (Preferably with a Sony Trinitron tube) or a Flat 
Panel (Active Matrix TFT). No matter what type is preferred, only high quality monitors should be used. 
 
All newer monitors can be used with ICM (the Color management engine include with Windows) to ensure correct 
calibration. ICM is compatible with the color management technology used by Apple (ColorSync) and the two systems 
can use the same ICC profiles.  
 
Although there are many methods used to calibrate monitors (Electronic devices to place on the monitor, monitors with 
auto calibration features etc.). Phase One recommends the following simple methods for good results. 
No special equipment is needed. 
Although there are many methods used to calibrate monitors,  
Phase One recommends the following simple methods for good results. No special equipment is needed. 
 
Calibration of Monitors in Windows: 
 
Turn the monitor on and let it reach normal working temperature – this may take 30 min. 
 

• Open the Display properties dialog box (Display is found inside the Windows “Control Panel” folder) 
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• In the Appearance tab set the desktop color to a neutral gray desktop background. Click “Apply”. The screen 
background is now a neutral gray. 

 
 
• In the “Control Panel” folder open the “Adobe Gamma” (installed with Adobe Photoshop) 

 
• Select the “Step by Step (Wizard)” option and be sure to select desired gamma “Windows Default”  gamma 2.20 

and hardware and adjusted white point 6500 K (Daylight). 
 

 
If you do not have the Adobe Gamma control panel you will have to make the adjustments manually as explained below, 
please bear in mind that this will not adjust your gamma and unless you have other tools to adjust the gamma, you 
would have to rely on the factory gamma setting of your monitor. 
 
 
Adjusting the Brightness and Contrast manually: 
 
Turn the monitor on and let it reach normal working temperature – this may take 30 min. 
 

• Set the contrast to 100%. Most monitors have control buttons at the front. Most TFT monitors do not let you set 
the contrast, so here you will only set the brightness. 

• Drag this document to align the black rectangle below with the bottom of the screen edge boundary. 
 

• Adjust the brightness of the screen so that the black rectangle below is is almost as black as the dark border of 
the screen. With some monitors it is possible to move the screen image to expose a larger border. This may help 
when evaluating how dark the border should be. 

 
• When this adjusting is done you might want to adjust the contrast back to less than 100% depending on the 

quality of your monitor. 
 
 
 

Drag the document to place this black rectangle at the edge of the screen and adjust the brightness so that black 
is almost as black as the boundary black edge of the screen. Also you should be able to see all tree fields below. 

3 fields
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Setting up Software 
 
The final step, setting monitor gamma, is done after configuring Photoshop. Please configure Photoshop before 
continuing. (See next section “Setting Up Photoshop”) 
 
Open the Adobe Gamma control panel, which is included with Photoshop, and found in the Help menu under Color 
Management. 
 

• If the control panel opens in “Assistant” mode, change to “Control Panel” mode, before continuing. Select the 
option “View Single Gamma Only” 

 
• Open Photoshop and navigate to the “Extras” folder Capture One software and open the PhaseOne-CMS 

Checker Lowres.tif. 
 

 
• At the bottom of the PhaseOne-CMS Checker are a color chart and a grayscale.  
 
• Adjust the Gamma control so that all the steps in the gray scale are clearly visible. To the left of the grayscale is 

an image of a model wearing a black hat. Ensure that there is detail in the hat. 
 
• Finally, check the lower right corner of the color chart. The color patch should be a deep “burgundy” red.  

 
Often only very slight changes in gamma are needed to give an optimal result. When satisfied, close the control  
panel and save the profile. 
 
Setting Up Photoshop 
 

• Start Photoshop. 
• In the Edit menu select Color Settings. 
• In the Settings pop up select Phase One Workflow 
 

 
Photoshop is now configured for use in the Phase One workflow. 
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Visual Inspection 
To test the Color management setup and make a visual inspection open the 
“PhaseOne-CMS Checker Lowres.tif” in Photoshop (Located in the “Extras” folder 
on the CD). 
The file should have an “Adobe RGB 1998” embedded profile, and therefore no 
color conversion is needed. 
 
Areas of special interest when evaluating the image: 
 

• The gray scale at the bottom should be evenly distributed, and you should be 
able to se the transition between 100 to 95 and 5 to 0. 

• The field in the lower right color of the colorchart should be deep red 
burgundy. 

• Details in the black hat of the lady in the lower right corner should be visible. 
• Look at the fruit and vegetables  in the top and judge if it looks like natural 

colors. 
• Skin tones of the portraits should look naturally 
• Finally the details in the waterline along the ship should be visible 
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4. Printing 
 
Destination profiles 
A destination profile is the profile that describes which device is used to reproduce the final image. In practice this could 
either be a printer or a monitor. Monitor setup has already been described in this guide. 
  
For the purpose of this discussion there are three basic groups of destination profiles for printers: 
 
Profiles installed with the Phase One software.  
These are basic CMYK printer profiles that cover the generic catalog printing standards in use around the world.  
As they are only generic profiles (and there are so many variations from printer to printer) the results from these  
profiles may not be perfect for every printing press. 
 
Profiles supplied with a studio printer.  
These profiles enable correct color reproduction in the majority of cases, and can be installed and used by the 
photographer with little difficulty. 
 
Customized profiles. 
To customize a printer profile  
(for either an RGB or CMYK printer) third-party software and hardware is necessary. The process to create a custom 
profile involves printing a standard target file that is supplied  with the hardware calibrator (called a spectrophotometer).  
The color values of the resulting print are then read by the device and a custom ICC profile is generated. 
 
Proofing with the studio printer 
Although it is not possible to describe the optimal procedure for all types of studio printer, Phase One has a set of basic  
recommendations that can be followed. Some printers may require specific setup procedures, which are clearly beyond 
the scope of this guide. The guidelines below are intended to assist the photographer in setting up the studio printer, but 
should not be considered a replacement for any guidelines and procedures defined by printer manufacturers. 
 
Many printers have a software or hardware user interface, which permits the user to adjust printer settings. 
Return to the default settings by disabling any color matching options and settings. 
Ensure that both the monitor and Photoshop have been set up correctly according to Phase One recommendations. 
Start Photoshop and open “PhaseOne-CMS checker.tif” Located in the Extras folder on the Capture One CD. This is a 
high-resolution version of the file used to adjust the monitor settings. 
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Make a print. 
Compare the image on the monitor to the printed image. Ensure that viewing conditions are optimal. Please note that to 
compensate for adverse viewing conditions the monitor should be fitted with a hood. This prevents light falling on the 
surface of the monitor.  
Ideally the viewing environment or should also be neutral gray, and the ambient lighting set at 5000 Kelvin, but since 
practically no monitor can display a good 5000 Kelvin and therefore is set to 6500 K it is of more importance that the 
light intensity is matched with the surroundings. A good way to evaluate images is by using light box where the light 
intensity can be adjusted. 
If the shadow details are less visible on the monitor, than on the print, adjust the gamma settings with the “Adobe 
Gamma” control panel or on a Macintosh with the Apple “Displays Preferences”. 
Do not change the monitor calibration settings in Photoshop as this will adversely effect the relationship between the 
Capture One software, and Photoshop. 
Save a copy of the “PhaseOne-CMS checker.tif” as a  CMYK file, in Photoshop. Open the file and compare it to the print. 
If there is a difference the shadow details between image on the monitor and the print adjust the gamma settings as 
needed. 
 
Adjust the gamma settings until the best result is obtained. Do not expect 100% accuracy, it is not technically possible 
given the gamut limitations of monitor and printer. The goal is to know exactly how an image will be reproduced on a 
printer as compared to the monitor. 
 
If there is significant variation in the color of the printed image, when compared to the monitor image, then please check 
the following points: 
 
Ensure that the monitor is setup according to Phase One recommendations. 
Ensure that the correct printer driver is installed according to the printer manufacturer’s recommendations. 
Ensure that Photoshop is setup according to Phase One recommendations. 
 
If significant color variations persist then the printer may require servicing. 
 
 


